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  A QUICK START TO EQS 6 FOR WINDOWS 
 
In the next several chapters of this user’s guide, we will provide detailed instructions on the use of various features 
of this program. In this chapter we provide you with an introduction to the program without going into a lot of 
technical details.  

 
It is quite easy to get started with the program, as we will show you with a few hands-on examples. After you 
complete these examples, we hope that you will have such a good understanding of the basic operations of EQS 6 for 
Windows that you can do real-world data analysis without reading this user’s guide any further. Please take a few 
moments to complete the examples shown below. 

Step 1:  Run EQS 6 for Windows 
 
To start running EQS 6 for Windows, double click on the EQS icon on your desktop. It looks like this: 

 

Figure 2.1  The EQS 6 for Windows Icon 
 
Two windows appear, one on top of the other, as shown in Figure 2.2.  
 

 
 

Figure 2.2  EQS 6 Startup Window 
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The top line is the title bar. Below it is the menu bar, containing two menu items. (You will see more items when 
you open a data file and run an analysis.)  Below the menu bar is the toolbar, with two buttons activated, and several 
inactive (grayed out). Below the toolbar, on the right side of the screen, is the text window which will be used to 
display various statistics, including the output log. Click on the OK button in that window to close it after you have 
reviewed the contents.  

Step 2:  Prepare your data 
 
Since EQS is a data-driven program, it is very important that your have your data ready before a plot is drawn, an 
analysis is computed, or a structural equations model (SEM) is prepared. Many of you probably have used EQS 5 or 
some other statistical package, so you will have some familiarity with data analysis. We will briefly introduce a 
number of ways to prepare your data. 
 

Create a Variance/Covariance Matrix 
 
One of the most commonly used data types in EQS is a variance/covariance matrix. These matrices can be found in 
published articles or computed from your own raw data. In this section, we will show you how to create a 
variance/covariance matrix by typing all the numbers cell by cell in the matrix data sheet provided in EQS 6. 
 
The example we are using in this data entry is a covariance matrix. It was computed from a sample of 932 
observations. This matrix is the file named manul4.dat on the EQS distribution CD and is installed in the Example 
folder. The content of this file is as follows: 
 

   11.834 
    6.947  9.364 
    6.819  5.091 12.532 
    4.783  5.028  7.495  9.986 
   -3.839 -3.889 -3.841 -3.625 9.610 
   -2.189 -1.883 -2.175 -1.878 3.552 4.503 
 

Normally, you can use the EQS data importing facility to import these data into EQS and save the data in an EQS 
system file. We want to show you that when this data file is not available, you can create the matrix from scratch. To 
start the EQS 6 Data Editor, you must go to the File menu, click on the New option and select the type of the new 
file you want to create, as shown in Figure 2.3.  In this example, we want to create a new EQS data file or an ESS 
file.   
 

 
 

Figure 2.3  New File Dialog Box to Create a Variance/Covariance Matrix 
 
Click the OK button.  You will see the Create a New Data File dialog box as shown in Figure 2.4. This dialog box 
allows you to choose between creating a new raw data file or a covariance matrix file. We select Create a 
Covariance Matrix by clicking on the appropriate radio button. Furthermore, we enter 6 in the Number of 
Variables edit box and 932 in Number of Cases since the data matrix is computed from a sample of 932 
observations. Click on the OK button to continue. 
 



 
 

Figure 2.4  Create a New Data File Dialog Box 
 
After clicking on the OK button in the dialog box shown in Figure 2.4, you will see the Data Editor in Figure 2.5. 
This Data Editor has eight rows and six columns. The last two rows, labeled __STD__ and __MEAN__, are for 
standard deviations and means (if any). The default standard deviations are set to 1.0 and means are set to 0.0. 
 
You can use this editor whether you have a covariance matrix or a correlation matrix. If you enter a covariance 
matrix, EQS will (before saving your data) convert your covariance matrix into a correlation matrix. The covariance 
matrix you have entered will be standardized, and the square roots of the diagonal elements will be placed in the 
standard deviation cells. 
 
If the matrix you are entering is a correlation matrix, you must enter the standard deviations manually. 
 

 
 

Figure 2.5  New Data Editor for Variance/Covariance Matrix 
 
You can start to enter the numbers in each cell of the Data Editor. Please note that after each number is entered and 
set (by pressing <Enter> key, a <Tab> key, or any of the arrow keys on the keyboard), the EQS Data Editor will 
automatically update the corresponding cell of the matrix. In other words, if you enter a number in row 2 column 1, 
after pressing the <Tab> key, you see the same number will appear in row 1 column 2. EQS is designed to save you 
time in the data entry process so that you do not have to type redundant numbers. Figure 2.6 illustrates how each 
element of the first column is updated automatically when the corresponding element of the first row is entered. 
 

 
 

Figure 2.6 Partially Completed Matrix File 
 
Figure 2.7 shows the complete Data Editor before it is saved. Move to row 2, column 2 and enter the data for row 2, 
as shown in Figure 2.7. Notice that all the cells contain the data as you have entered them. 
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Figure 2.7  A Completed Covariance Matrix 
 
You will have to save the matrix file before you can use it. To save the file, click on the File menu and select Save 
As.  After you click on the Save As menu, EQS will display the Save Selected Cases or Variables dialog box as 
shown in Figure 2.8. This dialog box allows you to choose whether to save all or selected variables. The default is to 
save all cases and all variables. The case selection option is grayed out when saving a covariance matrix. Because 
there are no raw data involved, case selection cannot be applied. 
 

 
 

Figure 2.8  Save Selected Cases or Variables Dialog Box 
 
After clicking the OK button, you will be given the Save As dialog box; see Figure 2.9. In general, we recommend 
the use of Save As instead of Save.  Here, the dialog box shows the name of the data file we enter.  In other cases, 
Save will use a default file name, while Save As allows you to choose a file name. 
 

 

 
 

Figure 2.9  Save As Dialog Box  
 
After you click OK in the dialog box above, you will see that the covariance matrix is converted into a correlation 
matrix. The advantage of this option is that you can see the correlation between two variables. When running EQS 
using this matrix, EQS will automatically convert the correlation matrix back to a covariance matrix. Figure 2.10 
shows the converted correlation matrix with standard deviations and means. You are ready to build an EQS model 
and start your analysis. 
 



 
 

Figure 2.10  Correlation Matrix with Standard Deviations and Means 
 

Create a New Raw Data File 
 
You can also use the built-in EQS Data Editor to create a raw data file. The process is very similar to that of the 
previous section.  Select the File menu New option. Then check the radio button Create a Raw Data File (Figure 
2.4) instead of Create a Covariance Matrix. 
 
Enter your data in the Data Editor as a matrix of n cases (rows) by p variables (columns) instead of  (p+2) by p for 
the covariance matrix. Any blank cells will be considered as missing data in this Data Editor. You can stop an 
editing session at any time, save it, and resume editing later. 
 
Before you can use the dataset you have just created, you must use the Save as option to save it as an EQS system 
file. 
 

Import an SPSS System File 
 
Importing an SPSS system file is a simple task in EQS 6. You can use File, and then Open to obtain an Open file 
dialog box. Change the file type to SPSS System File (*.sav) in the List Files of Type field in the lower left corner 
of the dialog box. Go to the folder where your SPSS file resides, double click on the SPSS file name. The targeted 
SPSS file will be opened in the EQS Data Editor. 
 

 
 

Figure 2.13  Open File Dialog Box to Import an SPSS File 
 
Figure 2.13 shows the open file dialog box to import an SPSS file. Of course, you must save the newly imported file 
as an EQS .ESS file before you use the data. 
 

Import an ASCII Data File 
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Another common file format is an ASCII (or raw) data file, i.e., a text data file containing scores of subjects on 
variables. EQS uses *.dat as the ASCII text data file extension. Although using another three-character extension is 
fine, *.dat is the most logical way to define a raw data file. In the example below (Figure 2.14), we choose *.dat in 
the List Files of Type box. 
 

 
 

Figure 2.14  Open File Dialog Box for ASCII Data Files 
 
Double click on the file name chatter.dat in this dialog box. Alternatively, you can click the file name and then 
click the OK button to open this raw data file. After double-clicking on the name of the file, or clicking the OK 
button, you will see the Raw Data File Information dialog box in Figure 2.15. 
 

 
 

Figure 2.15  Raw Data File Information Dialog Box 
 

Format 
 
The Raw Data File Information dialog box in Figure 2.15 requires information on the format of your data file. It is 
assumed that the data are organized in such a way that one or more rows or records of the file describe case number 
1, across all variables. Following case number 1 is case number 2, and so on. You can also specify a format to read 
the data in the file. There are two possible types of format: 

•  Free format 
•  Fixed format 

Free Format 
 

A data file in free format has at least one delimiter between the numerical values of adjacent variables. The delimiter 
can be a space, a tab, a comma and a space, or any character that you specify. If your data file is in free format, 
chose the radio button that matches the way your file was written. You have no need for Format Builder.  
 
When you need detailed information on the fixed format option using Fixed format, read Data Import and 
Export, Chapter 4. 
 



If your data file contains only variable data separated by a space, you can simply accept the default, Space. The 
number of lines per case is vital to EQS in analyzing the data. In addition to the number of lines per case, you can 
specify the character that designates missing values. 
 
Free Format Example 
 
For chatter.dat, accept the defaults of Space and Lines per Case =1. Click OK. The String prompt box in Figure 
2.16 appears. 
 

 
 

Figure 2.16  String Prompt Box 
 

EQS 6 for Windows found a string in the first case of the chatter.dat data file, so you see the String Prompt box. 
You get this box because EQS can read complex ASCII files in which the first case actually contains the variable 
names. 
 
If you did not want EQS to treat the string as variable labels, you would click No. However, since the first case 
contains the names of the variables in chatter.dat, click Yes, and the data file appears.  

 

Data File in Data Editor 
 

Actually, the file that you see in the Data Editor is a copy of the raw data file, so that your original file remains 
intact. This file is named chatter.ess, since it is now treated as a system file. The file appears on your screen with 
default variable names: VAR1, VAR2, VAR3, etc. Typically, you would now go to the Data menu and pull down 
the Information dialog box so that you could assign some identifying labels to the variables. But we shall save that 
step for later. (You can, of course, explore it now by yourself.)  Figure 2.17 shows the file brought up in the EQS 
Data Editor. 
 

 
 

Figure 2.17  Chatter.ess in EQS 6 for Windows Data Editor 
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The rows along the left give the subject, or case, numbers. The columns give the default variable names, VAR1, 
VAR2, and so on. Each entry, of course, gives the raw data score of a case on a variable. 
 

Note:  A data file must be visible and active before you can perform any meaningful function.   
 
We have purposely created the EQS 6 for Windows program to be data-oriented. All procedures available in EQS 6 
for Windows are based on a dataset being available in the Data Editor. Thus, you must have an open dataset in the 
Data Editor in order to continue processing. If you have no data in an existing file, you must create a new data file 
by clicking the File menu, selecting New, and typing in the numbers yourself. These numbers are entered cell by 
cell into the spreadsheet Data Editor so that the data file resembles Figure 2.17.  
 
After you import the ASCII data file in the EQS Data Editor, you should save the data before you perform any 
analysis. 
 

Step 3:  Activate a Program Function 
 
To activate a program function, we first open a data file. Retrieve the fisher.ess file by going to the File menu, 
selecting Open, and clicking on fisher.ess. This file contains 150 rows of numbers, along with a label for each of 
the variables. Previously, someone entered these labels via the Data menu, using the Information selection. 
 
The EQS program permits a variety of data-analytic procedures and manipulations, but here we will start with an 
example based on a histogram. Later we will turn to a regression analysis and build an EQS model. 
 

Plotting a Histogram 
 
After you have opened a data file, you can access many data manipulation procedures easily. Please note that there 
are 21 icons in the EQS 6 for Windows toolbar. These icons are displayed in Figure 2.18: 
 

 
Figure 2.18  EQS 6 for Windows Plot Function Icons 

 
The first 7 icons are the most frequently used Windows functions. Next are Diagrammer and the missing data plot 
icon. The remaining 12 icons are various plot tools. Each icon in the tool bar has a tool tip associated with it. When 
you position your mouse cursor on the tool icon for a few seconds, the tool tip will pop up telling you the icon’s 
function.  
 
Let’s choose the third plot option, the histogram, from the group of plot tools. A histogram provides a nice graphical 
way of showing the distribution of scores on a variable. A histogram also provides visual information that is relevant 
to evaluating model assumptions such as normality.  

 
Use your mouse to move the selector arrow to the histogram icon tool and click on it. The dialog box that serves the 
histogram option will open, as shown in Figure 2.19 below. You will see some options that we need not use here.  
 



 

Figure 2.19  Histogram Specification Dialog Box 
 
Click on the variable SEPAL_W in the list box, click the upper right arrow button to move the selected variable to 
the edit box, and then click the OK button. The histogram shown in Figure 2.20 will appear. 
 

 
 

Figure 2.20  Histogram Plot of Variable SEPAL_W 
 

There are other possibilities for further actions available within this window, using the Custom menu for the 
histogram plot. We shall not pursue these now. Instead we will explore one of the other functions available on the 
EQS 6 for Windows main menu (shown in Figure 2.2). 
 

Printing a Plot 
 
EQS 6 for Windows can print a hard copy of any plot that is in an active window. If the graphic display of your 
histogram is important to you, you might want to create a paper copy. Pull down the File menu and click the Print 
command. The histogram will be sent to the printer automatically. Note that only the histogram itself will be printed. 
The frame of the screen will be ignored. 
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You might want to use a plot in a different program, such as a word processor. There are two methods that you 
could use to bring a plot from EQS to another program.  
 

1. You can use the Copy option in the plot window (i.e., the icon with the camera 
shape) to copy the plot to the clipboard. You can then Paste the plot into the new document. 

2. You can use the File menu Save option to create a graphics file for import into other 
programs. EQS can export plot windows in two formats. They are BMP (a standard bitmap) and 
WMF (Windows Metafile Format). 

 

Summary 
 
The above steps of reading a dataset, saving the raw data in an EQS system file, generating the histogram, and 
getting a hard copy of the plot have taken a few pages to describe. However, the entire process takes only a few 
clicks or double clicks of the mouse, and very few keyboard actions. You will find, in general, that the choices EQS 
gives you are clear to you at all times. While you should know what you are attempting to do with your data, you 
need to remember very little about the program itself. EQS 6 for Windows aims to be easy and intuitive no matter 
what you want to accomplish. Doing statistics, you will see, can be fun! 
 

Discarding Windows and Files 
 
If you have been following this tutorial carefully, you will now have three screens available for study and analysis. 
The number and their content are shown in the Window menu. However, this is a good place to point out that you 
can have a maximum of 12 windows active at once. It is usually worthwhile to close or discard datasets and 
windows you no longer need.  

 
You can save and close most datasets. After you save a dataset as a file, click on the EQS icon in the upper left 
corner of the dataset window, and then click on Close to close the window. That dataset is removed from active 
memory and removed from the list in Window.  

 
You can save plots by using the File menu Save option. You can also print or discard plots. To discard a plot, close 
its screen. When you close the plot screen, that screen disappears from active memory and from the Window menu.  
 

A Multiple Regression Analysis 
 
Now we can turn to one of the most widely used methods for data analysis, linear regression. A standard problem in 
data analysis is predicting the scores on one variable from the scores on other variables. This is a problem in 
multiple regression. To illustrate the method, we will use an EQS system file called airpoll.ess. As usual, you must 
open the data file.  

 
At this point, the data file is placed into the active window, and you can proceed to the analysis. So far we have not 
told you what information the airpoll.ess dataset actually contains. In order to find out, you should open the data 
information dialog box. To get it, you pull down the Data menu and select Information. The dialog box in Figure 
2.21 will appear. 

 



 
 

Figure 2.21  Define Variable and Group Names Dialog Box 
 

This dialog box gives information on the file as it was created. The box shows that the file is based on 7 variables 
and 60 cases. It also shows how many cases in the Data Editor are marked or selected. In EQS 6 for Windows, it is 
possible to select certain cases for a particular analysis or further action. For example, you might want to perform an 
analysis on only one random half of all cases. In this example, we are using all cases in the data file, and none are 
marked.  

 
The List of Variables shows either the default variable names or any existing specific names. If you were to make 
changes to these names, the new names would be automatically transferred to the airpoll.ess system file. 
 
The Variable Type field displays the type of the variable you select from List of Variables on the left. Currently 
the EQS data sheet can display two types of data: numeric and string. You can perform computations on numeric 
data, but you cannot perform any analysis, computation, and/or transformation on string variables. The Variable 
Type field is used only for information purposes. 
 
When you press Cancel in the dialog box of Figure 2.21 the box disappears, and the Data Editor with the dataset 
becomes the active window again. You are now ready to specify the regression model.  

 
To specify a regression model, start by pulling down the Analysis menu from the main menu. Select Regressions…, 
then Standard Multiple Regression. A Multiple Regression dialog box will appear. The dialog box will be similar 
to Figure 2.22, but with all variable names displayed in the Variable List field. 

 

 
 

Figure 2.22  Multiple Regression Dialog Box 
 
The box is self-explanatory. You should select one variable from the left column, and move it to the Dependent 
Variable edit box by clicking on the upper right arrow. Then you can select one or more of the variables that 
remain, and move them to the Independent Variables list box on the right. Notice that the checkbox at the top 
allows you to add two variables for each case to your input data file, namely, the regression estimates based on the 
optimal prediction equation, and the residuals. When you add these data to the file, they are available for further 
analysis or plotting. In this example, we skip this feature.  

Note:   By now, you should notice that a right arrow ( ) means move to specify and left arrow ( ) 
means de-specify. This notation will be used throughout the program. 
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We will do a simple regression using MORTALIT as the dependent variable to be predicted. Search the Variable 
List until you find it, then click on the upper right arrow ( ) button. Then select EDUCATN, POP_DEN, and 
NONWHITE as the independent, or predictor, variables, and click on the lower right arrow button. 
 

Note:  To select multiple noncontiguous variables from the list, hold down the <Ctrl> key while 
clicking on each variable. To select multiple contiguous variables from the list, drag the cursor 
over each variable, or hold down the <Shift> key while clicking on each variable. 

 
After you specify these variables with mouse clicks, click the OK button to run the regression analysis program. 
After you press OK, wait a few moments. A message box will pop up to inform you that the analysis is done. Click 
OK, and you can review the regression analysis output. 
 
As stated above, the output of all statistical computations in EQS 6 for Windows is stored in an output file. The name 
of this output file bears the format of “data file name”+”date and time of the day”.  Thus, each of this output file is 
unique.  This file opens automatically when the EQS program starts, though it is empty until you do an analysis. 
However, at the end of a computation, this output file will automatically become the active window. You can scroll 
through the output to examine the results of your analysis.  

 
These output files are all stored in C:\EQS61\OUTPUT\ folder. You can access them using a text editor like EQS 
6.1’s text editor or Windows Notepad,  The output file has three parts, consisting of: 
    

1. Summary of variables and cases used  
2. Analysis of variance of the regression 
3. Statistics for the regression 

 
Figure 2.23 shows the output .log displaying test statistics for each independent variable, including unstandardized 
regression coefficient, ordinary standard errors, heteroscedastic standard errors, standardized coefficient, t-value, 
and p-value. 
 

STANDARD MULTIPLE REGRESSIONS 
4   Variables are selected from file  c:\eqs61\examples\airpoll.ess 
    
   Number of cases in data file are ...........      60 
   Number of cases used in this analysis are ..      60 
    
                         ANALYSIS OF VARIANCE 
                         ==================== 
  Source         SUM OF SQUARES    DF  MEAN SQUARES        F        p 
  ___________________________________________________________________ 
  REGRESSION         135854.579     3     45284.860   27.416    0.000 
  RESIDUAL            92498.190    56      1651.753 
  TOTAL              228352.770    59 
  ___________________________________________________________________ 
    
  Dependent Variable =  MORTALIT 
  Number of obs.     =        60 
  Multiple R         =    0.7713 
  R-square           =    0.5949 
  Adjusted R-square  =    0.5732 
  F(  3,    56)      =   27.4162 
  Prob > F           =    0.0000 
  Std. Error of Est. =   40.6418 
  Durbin-Watson Stat.=    1.7809 
    
=======REGRESSION COEFFICIENTS======= 
                                          HETERO-  
                            ORDINARY     SCEDASTIC 
  VARIABLE             B   STD. ERROR   STD. ERROR       BETA       t      p 
  ____________________________________________________________________________ 
  Intercept     1142.047       79.230       94.778               12.050  0.000 
    EDUCATN      -25.507        6.598        8.801      -0.347   -2.898  0.005 
    POP_DEN        0.008        0.004        0.007       0.187    1.179  0.243 
   NONWHITE        4.000        0.608        0.710       0.574    5.637  0.000 
  ____________________________________________________________________________ 

 

Figure 2.23  An Example of Regression output 
 



 
For the sake of brevity, this concludes the regression example.  Let us now turn to a structural equation model. 
 

Step 4:  Create and Run an EQS Model 
 
EQS 6 has an advanced model-building facility to help you build some standard models. You only need to specify 
the relationship between variables in the form of dependent-independent variables and/or correlations. Based on the 
type of model you want to create, EQS will build the diagram for you. Let’s try some of these exciting features: 
 

A Path Analysis Model 
 

The path model is a commonly used model that can be built easily. The model is actually a simultaneous equations 
model with some correlation among independent variables. Let’s use the dataset manul4.ess. The dataset contains 6 
variables and 932 observations (see Figure 2.24). We have edited the variable names in the dataset so that they are 
meaningful. You can click on Data and then Information to customize variable names. Detailed information on 
customizing variable names will be discussed elsewhere in this manual. 

 

 
 

Figure 2.24  Test Dataset to Create a Path Model 
 
Let’s start building the path model, which is the model described in EQS 6 Structural Equations Program Manual. 
In the data window, you must click File, and then New and change the file type to Diagram File (*.EDS) which will 
open a blank diagram window, or else click on the Diagrammer icon on the toolbar as shown in Figure 2.25 to 
activate New Model Helper.  The latter is simpler, so we click on it now.  
 

  or    
 

Figure 2.25  New Diagram Window or Diagrammer to Activate New Model Helper  
 

 

Build a Path Model 
 
As you can see in Figure 2.26, the New Model Helper contains four picture buttons and a Cancel button. Each of the 
first three picture buttons contains a series of procedures to help you create an EQS model. The fourth one, “Diagram 
Window”, opens a blank diagram window for you to draw a new diagram. Since we want to create a path model 
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now, let’s click on the top picture icon. A note on the dialog box tells you that it is a one-step process to build a path 
model. 

 

 
 

Figure 2.26  New Diagram Window Options 
 
You will be shown a Path Model Builder dialog box as shown in Figure 2.27. This dialog box contains three parts. 
The far left section is the list of all variables in the data file. The middle section is a regression specifier. The far 
right section is the path model. 
 
The unique feature of a path model is that all the variables used in the model are measured variables. There are three 
steps in this dialog box. 
 
Step 1:   You must specify a dependent variable from the variable list on the left side of the dialog box, and click 

on the top right arrow ( ) button to move the variable to the Dependent Variable edit box.  
 
Step 2:   After the dependent variable is specified, you must select the independent variables from the variable 

list box and move them to the Its Predictors list box (press the <Ctrl> key and click on the variables in 
the variable list box if you want to select a number of non-contiguous variables), by using the lower 
right arrow button. 

 
Step 3:   After moving all of the predictors of this dependent variable, use the Add button to move the regression 

equation to the Path Model section on the right hand side. 
 
Repeat steps 1 - 3 until all regression equations are moved to the Path Model section. You have completed the 
process of building a path model. These equations are your path model. Click on the OK button, and you will see 
that EQS opens a diagram window and puts the path model you have specified in the window (see Figure 2.28). 
 
Our path model has two equations: 
 
 ANOMIE71 = *ANOMIE67 + *POWRLS67 + error; 
 POWRLS71 = *ANOMIE67 + *POWRLS67 + error; 
 
To build such a model, we first click on ANOMIE71 and move it to the Dependent Variable box. Then we select 
ANOMIE67 and POWRLS67 and move them to the Its Predictors list. The first equation is complete, so we click 
on the Add button, and the first equation is moved to the Path Model section. For the second equation, we click on 
POWRLS71 and move it to the Dependent Variable box. For independent variables, we select both ANOMIE67 
and POWRLS67 and move them to the Its Predictors list box. Click on the Add button to add the second equation 
to the Path Model section. 



 
The path model building process is complete and we should click on the OK button. The model is created as shown 
in Figure 2.28. (Note that this model was prepared for this manual. Your screen version will have shading.) 
 

 
 

 
 
Figure 2.27  Path Model Builder Dialog Box 

POWRLS67

ANOMIE71ANOMIE67

POWRLS71 E4

E3

 
   

Figure 2.28  Path Model Created by New 
Model Helper 

 
   

 
The path model you are specifying has been built on the Diagrammer with very little effort. You are ready to run 
EQS based on the model you just built.  
 

Run the Path Model 
 
You finish building the EQS model from the diagram shown in Figure 2.28 by using a few more clicks. While on the 
diagram window (please note that both your data and diagram are active at this point), pull down the Build_EQS 
menu and select Title/Specifications.  Before EQS runs the model, you will be asked to save the model file in a 
dialog box shown as Figure 2.29. You have to save the model file for EQS to continue.  
 

 

Figure 2.29  Save As Dialog Box to Save the Diagram File 
 
After you save the diagram file, an EQS model file window will open with an EQS model listed on the window then 
EQS Model Specifications dialog box (Figure 2.30) appears.  
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Figure 2.30  EQS Specification Dialog Box 
 
In this EQS Specification Dialog Box, the data file name has been set and the estimation method is given. Most of 
the model’s input information has been provided. You are ready for the next step, so click on the OK button in the 
EQS Model Specifications dialog box.  You will now be on the EQS Model file window where there are EQS 
commands on the screen associate with the path diagram you just created in Diagrammer as shown in Figure 2.31.  
Please note that this EQS Model file appears to be a text file but it is not.  You could modify the contents of the 
model only through the sub-menus in Build_EQS menu.  The model in this point is ready to run. 
 
 

/TITLE 
EQS model created by EQS 6 for Windows -- c:\eqs6\examples\manul4.eds 
/SPECIFICATIONS 
DATA='c:\eqs61\examples\manul4.ess'; 
VARIABLES=6; CASES=932; GROUPS=1; 
METHODS=ML; 
MATRIX=CORRELATION; 
ANALYSIS=COVARIANCE; 
/LABELS 
V1=ANOMIE67; V2=POWRLS67; V3=ANOMIE71; V4=POWRLS71; V5=V5;  
V6=V6;  
/EQUATIONS 
V3 =  + *V1 + *V2 + 1E3; 
V4 =  + *V1 + *V2 + 1E4; 
/VARIANCES 
V1 = *; 
V2 = *; 
E3 = *; 
E4 = *; 
/COVARIANCES 
V2 , V1 = *; 
/PRINT 
EIS; 
FIT=ALL; 
TABLE=EQUATION; 
/STANDARD DEVIATION 
/MEANS 
/END 

 
Figure 2.31  A Path Model Command File Built by the Build_EQS Process 

 
Go back to the Build_EQS menu, pull it down and select the Run EQS option to run it. You will be asked again to 
save the EQS model file as the dialog box looks like Figure 2.29 with EQS Model File (*.EQX) as the file 
extension.  After you click on the Save button, EQS will start to run. Depending on the speed of your computer, the 
EQS running status will be displayed briefly until it is done. The output of EQS will be automatically fetched to the 
front window for you to examine. 
 
We will not show the EQS output here. Detailed information on EQS output will be provided and illustrated in EQS 6 
Structural Equations Program Manual. 
 



A Confirmatory Factor Analytic Model 
 
Let’s build a confirmatory factor analysis model, using an example from the EQS 6 Structural Equations Program 
Manual. It uses a raw score dataset called manul7a.ess, which is stored as an EQS system file. This data file has six 
variables. We want to show you how to build a six-variable, two-factor confirmatory factor model. We will develop 
the model based on the raw data. If the file contained the covariance or correlation matrix for these data, we would 
use a virtually identical procedure. 
 
First, of course, you have to activate the EQS 6 for Windows program if it is not already active, and open the 
appropriate data file. Pull down the File menu from the main menu and select the Open option to get an open file 
dialog box. The dialog box shows the list of files. Select manul7a.ess, then click OK or press the <Enter> key, or 
double-click manul7a.ess to bring the file to the Data Editor. 
 
After deciding on the dataset, we can start building the EQS model. To build an EQS model in the conventional way, 
you type in the equations, variances, and covariances, character by character using a text editor. EQS 6 for Windows 
provides two more advanced ways to build the equations.  

 
1. The Building an EQS Model Using the Diagrammer section of this chapter 

illustrates how you can build a model by simply drawing a diagram on the screen and letting the 
program generate the model for you. 

2. The Building an EQS Model by Using Equation Table section of this chapter 
shows that you can create a table consisting of the components of the equations. Then fill in the 
free parameters by clicking on cells with your mouse.  

 
Either method will substantially reduce the time required to build a model, compared to other methods. 

1. Building an EQS Model Using the Diagrammer 
 
You must open the New Model Helper to build the new model. To do this, click the Diagrammer icon (shown on 
the right side of Figure 2.25) from the tool bar. You will see New Model Helper (shown in Figure 2.26). Click on 
the second picture button that shows Factor Model. You will see a series of dialog boxes, which will help you 
create the factor model. These dialog boxes are  
 

1. Dialog box to specify all factor structures 
2. Dialog box to specify all structural equations 
3. Dialog box to specify all factor correlations 

 
The first dialog box accepts factor loading specifications. It allows you to obtain all factor structures by providing 
their indicators. The dialog consists of three main parts. The left hand side is a Variable List box. The middle 
section is a Factor Structure box, and the right hand side is a Model Components group box.  
 
You create a factor structure by moving a factor’s indicators from the Variable List to the middle Indicators box. 
When one factor is done, you add it the Model Components section on the right hand side of the dialog box. Repeat 
this process until all factor structures are created. 
 
In this example, you will select V1, V2, and V3 and click on the right arrow button to move them to the Indicators 
box. Click on the Add button to create the first factor structure. Next, select V4, V5, and V6, click on the right 
arrow button to move them into the indicator list and click on the Add button to create the second factor structure. 
Click on Next, which brings up Step 2.  
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Figure 2.32  Factor Loading Specifications Dialog Box 
 
Step 2 of the Factor Model Builder option is to create structural equations.  A structural equation is a regression 
equation whose dependent variable is a factor. In other words, a factor is predicted by other factors. In the dialog 
box (Figure 2.33), all the factors created from the previous step are displayed in the factor list on the left. You must 
move dependent and independent factors as if you were creating a regression model. You add each equation to the 
Structural Equations pool by clicking on the Add button. 
 

 
 

Figure 2.33  Structural Equation Specifications Dialog Box 
 

In our example, we do not have structural equations since we are creating a confirmatory factor model. Simply click 
on the Next button and move on to step 3. 

 
The last step of the three-step Factor Model building process is to specify factor correlations. In this factor 
correlation dialog box (Figure 2.34), all the independent factors are listed in the Independent Factors list box. You 
can select any two factors representing the correlation between these two factors. Or alternatively, you can click on 
the All button, which means to correlate all independent factors. So click on the All button to correlate between F1 
and F2, and then click on the OK button.  

 

 
 

Figure 2.34  Factor Correlation Specification Dialog Box 



 
You will see a diagram window with a two-factor CFA model (Figure 2.35). You are nearly ready to run this model. 
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Figure 2.35  Two-Factor CFA Model 
 

Build EQS Model 
 

Now that you have opened the data file and drawn the diagram, you are ready to finish building the EQS model. 
Click the Build_EQS selection from the main menu. You can see from the drop-down menu that there are many 
items in this menu, but only two items are black and active. (The remaining options are grayed out and inactive.)  
 
This choice of only two options indicates that you should start with the item on top of the menu, 
Title/Specifications, to build an EQS model. By selecting this option, you can see a new dialog box:   

 
Note:  You will be asked to save the diagram before the EQS Model Specifications dialog box 

appears.  EQS 6 uses data file name plus .eds as the extension as the default diagram file 
name. We recommend you use the default name since this name coincides with your data file 
name (except for the extension .eds).  

 
 

 
 

Figure 2.36  EQS Model Specifications 

 

 
 

Figure 2.37  Additional Options 
 
The new dialog box called EQS Model Specifications will appear as shown in Figure 2.36. This box has the 
information required in the /SPECIFICATIONS paragraph of the EQS program. By default, the EQS Model 
Specifications box automatically has most of the information you need to specify a model. Some of the default 
information is from the *.ess file (here, manul7a.ess), and some reflects choices typically made in structural 
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modeling. The file name, number of variables, number of cases, method of analysis, and type of input data (raw 
data, covariance matrix, etc.) have been set to default values.  

 
For our illustration, we want to show you a new option that may be useful; EQS can display its output in HTML 
format like the documents you read on the World Wide Web. It also has a built-in HTML file viewer that allows you 
to go to an exact paragraph in the file. To turn on this HTML option, you must click on the Misc. Options button in 
the EQS Model Specifications dialog box. The Additional /SPECIFICATION options dialog box is shown as 
Figure 2.37. In the Type of output file group box, select the Regular ASCII file option, then click the Continue 
button to close it. You will return to the EQS Model Specifications dialog box. Click the OK button to close it. You 
will see the EQS model instructions in the text window. You are now ready to run EQS.  The following shows the 
model file that is created. 
 

/TITLE  
  EQS model created by EQS 6 for Windows -- c:\eqs61\examples\manul7a.eds 
  /SPECIFICATIONS 
  DATA='c:\eqs61\examples\manul7a.ess'; 
  VARIABLES=6; CASES=49; GROUPS=1; 
  METHODS=ML; 
  MATRIX=RAW; 
  ANALYSIS=COVARIANCE; 
  /LABELS 
  V1=V1; V2=V2; V3=V3; V4=V4; V5=V5;  
  V6=V6;  
  /EQUATIONS 
  V1 =  + 1F1  + 1E1; 
  V2 =  + *F1  + 1E2; 
  V3 =  + *F1  + 1E3; 
  V4 =  + 1F2  + 1E4; 
  V5 =  + *F2  + 1E5; 
  V6 =  + *F2  + 1E6; 
  /VARIANCES 
  F1 = *; 
  F2 = *; 
  E1 = *; 
  E2 = *; 
  E3 = *; 
  E4 = *; 
  E5 = *; 
  E6 = *; 
  /COVARIANCES 
  F2 , F1 = *; 
  /PRINT 
  EIS; 
  FIT=ALL; 
  TABLE=EQUATION; 

  /END 

   

 

EQS Model File 
 
Whether you build your model from a diagram or an equation table, you finish building an EQS model with the 
Build_EQS feature. As this is done, you can see that the EQS command language is built line by line and is written 
onto the background window. The file that is created is called manul7a.eqx by default. We use .eqx as the EQS 
model file extension. This file contains detailed model information; it can be saved and used later. When the cursor 
returns to the manul7a.eqx window, your model is complete, and you are ready to run EQS.  If you need to add any 
options to the model, you must go to Build_EQS and select the appropriate menu item. When you finish making 
changes in the dialog box(es), the .eqx file window will be rewritten to reflect those changes. Notice that this 
window cannot be edited directly.  Thus, all the changes must be made in relevant dialog boxes.  
 

Run EQS 
 
To run EQS, go back to the Build_EQS menu and select Run EQS.  
 



Before the program actually runs the EQS job, it displays a Save As dialog box as in Figure 2.30. For safety’s sake, 
you should save your EQS model file before running it. 
 
We have been working on the manul7a.ess data, you have saved the diagram file as manul7a.eds, and thus the 
default file name for the EQS model is manul7a.eqx.  In naming your diagram file, be sure to select a file name that 
will remind you of your data file name. 

 
The output from the run will be named manul7a.htm. If you had not chosen HTML output, you would have your 
specified file name, with the *.out extension. So, work.eqx will yield work.out as the output file, and manul7a.eqx 
will yield manul7a.out. 
 

Examine the EQS Output File 
 

When the EQS model run is complete, the output is automatically sent to the front window. If you chose to display a 
regular ASCII output, the output file will be displayed in a text editor. You can scroll up and down. You can even use 
the Find/Replace function to locate specific information. If, however, you requested an output file in HTML format 
(as in this example), the output file will be placed in the HTML file viewer. You can click on the pre-defined topics 
to position the output to the exact paragraph you want to read. 
 
The first part of the output will echo your input file, so that you can verify what job was actually run. Beyond that, 
the output file includes all the standard results from a structural modeling run. We do not describe this output any 
further, because it is fully documented in the EQS 6 Structural Equations Program Manual.  
 

Examine EQS Output on the Diagram 
 
If you have created the EQS model using the diagram method, the parameter estimates will be brought to the 
diagram when the job is done. When building an EQS model file using a diagram, the program will insert an EIS 
command into the /PRINT section automatically. The EIS command will write all estimates to an external file called 
input_file_name.eis. The Diagrammer can read those estimates later, after the EQS job is done.  
 
To review the parameter estimates from the diagram, choose the Window menu and select the diagram file name 
(i.e., manul7a.eds). The diagram window will appear with some basic statistics displayed at the bottom of the 
diagram window. If you want to see the estimates of each parameter, click the View menu and select Estimates and 
Parameter estimates. The diagram window will be redrawn with parameter estimates embedded in the paths 
(Figure 2.38).  

 

 
 

Figure 2.38  Path Diagram with Embedded Parameter Estimates 
 
Now close the diagram window, and let’s try doing the same thing a different way. 
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2. Building an EQS Model by Using Equation Table 
 
Building an EQS model using the equation table is particularly useful when your model is very large. Diagrammer is 
convenient but can only house a limited number of objects due to the constraints of a single page display. 
 
After you bring the desired data into the Data Editor, you are ready to build the EQS model. Let’s assume that you 
have opened manul7a.ess.  First, click on Build_EQS from the main menu. You can see that there are many items in 
this menu, but only two items are black and active. (The remaining options are grayed out and inactive.)  
 
This choice of only two options indicates that you should start with the first item on the menu, Title/Specifications, 
to build an EQS model. After you select this option, you see an EQS Model Specifications dialog box. This dialog 
box, Figure 2.36, is described above. 
 
For many analyses, the default values in this dialog box will meet your needs. Notice that you can specify a multiple 
group model, and that you can define certain variables in your file as being categorical variables for the new 
polychoric-polyserial methodology in EQS. After you complete the Model Specifications dialog box, the relevant 
information is transferred automatically to the *.eqx model file that is being built.  
 

Equation Table Specifications 
 
For our illustration, there is no reason to change anything in this dialog box. Therefore, click the OK button. You 
then go back to the Build_EQS menu and select Equations.  You will be given the dialog box Build Equations as 
shown in Figure 2.39. This box builds the heart of your model. Typically, you will be doing a latent variable model 
that uses a number of factors. Click on the Number of Factors field and type 2. The number of variables in your 
data file is already known by the program and is displayed in the field Number of Variables.  
 

 
 

Figure 2.39  Build Equations Dialog Box 
 
As you can see in the first line of Figure 2.39, if we had run a preliminary factor analysis, the number of factors 
would already be known, and the equations could be built automatically from the factor analysis results. In our case, 
we must enter the number 2 for the number of factors.  
 
After you have done this, click the OK button to continue to build the EQS model. The Create Equation dialog box 
will appear. This dialog box, shown in Figure 2.40, has a table-like entry field with the variables (Vs) and factors 
(Fs) listed in both rows and columns.  



 

 
 

Figure 2.40  Create Equation Dialog Box 
 

Each row corresponds to a dependent variable in your path diagram, i.e., a variable with one or more one-way 
arrows aimed at it. Thus, each row corresponds to a possible equation that you might build. Each column gives one 
of the possible predictors of that variable.  
 
There are three simple ways to specify your equations.  

 
1. Use your mouse to click on each aqua-colored cell that should be a free parameter in the model. 

As you click on a cell, an asterisk will appear. 
 
2. As an alternative, you can use click and drag. Position your mouse pointer in the upper left cell, 

inside the cell defined by V1 and F1. Click your mouse button, and hold down the button and 
drag the pointer so that it terminates in the V3,F1 cell. The idea is to cover the top three cells 
under F1 by an active rectangle. Now, release your mouse button. You will see a dialog box 
Start Value Specifications (Figure 2.41). The default radio button is set to Fix one and free 
others. This option allows you to fix the first factor loading at one and free the other loadings if 
you have covered more than one factor loading. This dialog box also allows you to specify 
other types of models (e.g. latent growth curve model) with ease. Click OK to continue, then 
select with your mouse an active rectangle covering the V4, V5, V6 cells under F2. Click OK in 
the Start Value Specifications box, and your table will look exactly like Figure 2.40. 

 

 
 

Figure 2.41  Start Value Specifications Dialog Box 
 

3. You can double-click on any cell. The cell will change color to yellow and the cursor will 
appear in the cell. You can add and/or change the start value in the cell and end the start value 
with an  asterisk (*) if it is a free parameter. To enter your changes, you must type a tab, an 
Enter key, or double click on another cell. 

 
In this example, we use the default start value option. Variables V1-V3 are indicators of Factor 1, and V4-V6 are 
indicators of Factor 2. Make the relevant selections now. If you make a mistake, you can click again on a cell to 
unselect a previously-selected parameter. You should get a result that looks like Figure 2.40.  
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Each asterisk in a cell represents a free parameter in your model. The unmarked factor loadings are automatically 
fixed at zero by the program. This completes the setup of equations. When the dialog box looks like Figure 2.40, 
Press OK. 
 

Variance/Covariance Table Specifications 
 
Of course, a model must include variances and covariances of independent variables as well as equations.  Next we 
specify these parameters. The Create Variance/Covariance dialog box appears automatically, as shown in Figure 
2.42.  
 

 
  

Figure 2.42  Create Variances/Covariances Dialog Box 
 
In this box, blank entries are parameters fixed at zero, while entries that will become free parameters must be 
specified with an asterisk. The diagonals of this matrix represent the variances of the variables, while the off-
diagonals deal with the covariances or correlations between pairs of variables. 
 
When the dialog box appears on the screen, the independent variables from the equations box, plus the implied 
residual variables, are shown as the independent variables in the model. Each diagonal cell contains an asterisk, 
indicating that the variances of F1, F2, E1, ..., E6 are taken to be free parameters. This may or may not be the correct 
specification that you have in mind, so you should adjust the box to meet your specific model needs. 
 
Since we have fixed one of the factor loadings for each factor, we need not do anything to the variances. We want to 
let the two factors correlate, so we place an asterisk in the F2,F1 cell. The result will look like Figure 2.42. (We 
could also have made these three changes at once by moving the pointer above and left of the F1,F1 position, 
clicking, dragging into the E1,E1 position, and then releasing.)   
 
Now that we are finished making the variance and covariance specifications, press the OK button.  
 

EQS Model File 
 
Whether or not you build your model from a diagram or an equation table, you finish building an EQS model with 
the Build_EQS feature. As this is done, you can see that the EQS command language is built line by line and is 
written onto the background window. The file that is created is called manul7a.eqx by default. The following shows 
the model file that is created. 



 
/TITLE 
  EQS model created by EQS 6 for Windows -- manul7a.ESS 
/SPECIFICATIONS 
   DATA='c:\eqs61\examples\Manul7a.ess'; 
   VARIABLES=6; CASES=49; GROUPS=1; 
   METHODS=ML; 
   MATRIX=RAW; 
   ANALYSIS=COVARIANCE; 
/LABELS 
  V1=V1; V2=V2; V3=V3; V4=V4; V5=V5;  
  V6=V6;  
/EQUATIONS 
  V1 =  + 1F1  + 1E1; 
  V2 =  + *F1  + 1E2; 
  V3 =  + *F1  + 1E3; 
  V4 =  + 1F2  + 1E4; 
  V5 =  + *F2  + 1E5; 
  V6 =  + *F2  + 1E6; 
/VARIANCES 
  F1 = *; 
  F2 = *; 
  E1 = *; 
  E2 = *; 
  E3 = *; 
  E4 = *; 
  E5 = *; 
  E6 = *; 
/COVARIANCES 
  F2 , F1 = *; 
/PRINT 
  FIT=ALL; 
/END 

 
 

If you made a mistake in the file, or if you change your mind about any of the specifications, you can move your 
cursor into the window that contains the manul7a.eqx file. You can modify this file by going back to the 
Build_EQS menu. Select the menu item for the paragraph you wish to change. You will be given the dialog box 
associated with the paragraph. Change it, and EQS will update manul7a.eqx automatically. 
 

Run EQS and Examine the EQS Output File 
 

To run EQS, go back to the Build_EQS menu and select Run EQS.  Running an EQS model has been discussed 
previously where we build the model using New Diagram Builder. 
 
The EQS output will appear automatically when the job is done. The name of the output file is always the input file 
name, with .out or .htm replacing .eqx. We do not describe this output any further, because it is fully documented in 
the EQS 6 Structural Equations Program Manual.  


